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WYNN Tip Sheets 

 
 

1. Introduction to WYNN 
 

2. Customizing the Visual & Auditory Presentation 
 

3. Changing Speech Drivers 
 

4. Studying 
 

5. Vocabulary 
 

6. WYNN with the SQ3R Study Method 
 

7. Internet 
 

8. Word Prediction Learning Text 
 

9. Scanning/Preparing Documents  
 

9a.Scanning Tips 
 

9b. Opening PDF and other File Formats… 
 

9c. Dynamic Zoning 
 

9d. Document Clean-up 
 

10. Creating a Custom Tool Bar 
 

11. Sample Activities for Using WYNN 
 

Explore these tip sheets and more at: 
http://www.freedomscientific.com/lsg/products/wynn_tipsheets.asp 
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1. An Introduction to WYNN  
 
WYNN is a software program for people who struggle with reading and writing.   WYNN 
lets you hear and see what you type into the computer, files that are already in the 
computer, and the Internet.   
 

  WYNN has four, color-coded tool bars.  Clicking on the Next button at the left of 
each tool bar will rotate through the tool bars. 
 

 There is a Read button on each tool bar.  Click the Read button to hear each 
word being spoken at the same time as you see it being spotlighted.   
 
 
On the BBlluuee  TTooooll  BBaarr you can manage your files. 

 
 
Scan a document.  Start a New File.  Open a File.  Read from the Web. 
 
The GGrreeeenn  TTooooll  BBaarr lets you change the way text looks and 
sounds.   

 
Change the text size, spacing, and color.  Change the speed of the speech. 
 
The PPiinnkk  TTooooll  BBaarr helps you study and learn.    

 
Use the talking dictionary.  Highlight text and create lists.  Record a note. 
 
The YYeellllooww  TTooooll  BBaarr helps with writing.   

 
 

Use Outlines to organize thoughts.  Use Word Prediction.  Help with 
spelling. 
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2. Customizing the Visual and Auditory Presentation 
 

 
 

1. To adjust the visual settings for Size, Line Spacing, Word Spacing, 
Margins, and background Color to each user’s preferences and 
needs, click the corresponding button to rotate through the options. 

 
2. To turn on masking, first click the “Write” button to enter “Read Only” 

mode.  Then click the Mask button to rotate through the masking 
options.  Once masking is set, you may return to “Write” mode.  You 
will only see text masked when you click the Read button to read.   

 
3. To adjust the speech settings for Self Paced reading, the Rate of 

speech, and the amount of Pause between sentences, click the 
corresponding button to rotate through the options. 

 
4. To switch between AT&T Natural Voices and IBM’s ViaVoice, Go to 

the Settings menu and select Retrieve Settings.  Choose the 
synthesizer you wish to use. 

 
5. Additional Visual Settings and Speech Settings are available through 

the Settings menu located above the green tool bar. 
 
Any changes made to the visual and speech settings will be 
automatically saved for the logged in user.  (Note: this is new for WYNN 
4.0)   
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3.  Changing Speech Drivers in WYNN 4.0 
 
 
WYNN comes with two speech synthesizers, IBM’s ViaVoice and AT&T 
Natural Voices.  If you choose the “typical” install, ViaVoice is enabled by 
default.  Once you have installed the AT&T voices, you may switch 
between the two synthesizers at any time while using WYNN. 
 

1. Go to the Settings menu. 
2. Choose Retrieve Settings. 
3. Choose AT&T Speech or ViaVoice Speech. 
4. Click the OK button. 

 
If you wish to explore the voices or other languages* that come with each 
synthesizer, or any of the other speech settings: 
 

1. Go to the Settings menu. 
2. Choose Speech Settings. 
3. Choose the Synthesizer, then the Language you wish to use. 
4. Use the Test button to try out your new settings. 
5. Click the OK button to change or the Cancel button to go back to 

your previous settings.   
 

Note:  Whatever settings are in effect when you exit WYNN will be enabled 
next time you log in.  These settings will remain until you change them.   
 
* U.S. English and Spanish are automatically installed with Via Voice during 
the WYNN installation process.  Additional ViaVoice languages can be 
installed choosing “Custom” install, or reinserting the program CD.  AT&T 
voices are installed from a separate CD that ships with the WYNN program 
CD.   
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4.  Studying with WYNN (Pink Tool Bar) 
 

You can create study guides, isolate vocabulary words, or categorize 
and organize ideas using the steps below. 
 

1. Bring your text into WYNN (scan from print, copy and paste from the 
Internet, or open an electronic document) 

  
2. Use WYNN’s Highlight pens to isolate relevant information 

 
a. You may use just one color to isolate key vocabulary 
b. Or, you may choose to use one color for key points and another 

for supporting points 
c. Or, you may use different colors to categorize topics 

i. Parts of speech 
ii. Characters in a story 
iii. Comparisons  

 
3. Once text is highlighted, click the List button to create a separate 

document with just the highlighted text 
 

a. Choose List By Order to keep key points and supporting points 
together 

b. Choose List By Color  to group items by category 
 

You now have a separate, fully editable document with just the key information.  You 
can switch between this “List” document and your original document with the Other Doc 
button. 
 
* You may also use the Bookmark button to isolate text and the List button 
to pull out Bookmarked text.   
 
Highlighting, Lists, text Notes, and Voice Notes are available in either Exact 
View or Text View.  Mark-ups made in one view will be accessible in the 
other view. 
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5. Learning Vocabulary with WYNN (Pink Tool Bar) 
 
 

1. Get the vocabulary words into WYNN (scan them, type them, or 
highlight them in an existing document and create a separate List) 

 

2. Use WYNN’s Dictionary to look up the definition. 
a. Use the Read > button to hear the definition. 
b. If there is a word in the definition that needs to be defined, 

double click on it.   
c. Close the Dictionary when done with the word. 
 

3. Move to the next word and repeat. 
 
Additional Activities: 
 

1. Paste a definition from the Dictionary into the document 
a. Select a definition from the Dictionary 
b. click the “Copy to Clipboard” button 
c. Close the dictionary. 
d. Put the cursor where you want to paste the text, then do one of 

the following: 
i. Use the Copy/Paste button 
ii. Use a right mouse click, then choose Paste 
iii. Select Paste from the Edit menu 
iv. Use the Paste shortcut command, Ctrl V 

 

2. Create a Text Note with the definition 
a. Click on the Text Note button and paste the definition into it, or 
b. type in your own definition using vocabulary at the student’s 

level 
*(This is a great way to “hide” the definition until it’s requested with 
a double-click on the notepad icon that has been inserted) 
 

3. Use WYNN’s Voice Note to record a sentence using the word. 
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6. Improving Reading Comprehension Using WYNN and SQ3R 

The SQ3R study method enables students to actively study textbooks. This method 
helps students process, analyze and synthesize information, which in turn leads to a 
better comprehension and mastery of the material.  WYNN supports this process with 
tools on WYNN's Pink, Study Tools toolbar. 

SURVEY - Before reading the actual chapter, read the introduction and summary (if 
given). Skim through the chapter paying attention to topic headings, bold-faced words, 
summaries, or key points. These can give you an idea of the general structure and 
content before you begin reading. From the Pink Toolbar use Highlight or Bookmark to 
mark key information. 

QUESTION - Set a purpose for your reading by developing questions about the 
material. Use the topic and heading information you gathered in the survey step to 
create questions to be answered. Ask yourself who, what, where, when, why, and how 
questions. Questions are most beneficial when they are general, covering main topics 
and important points. Use the Voice Note or Text Note on the Pink Toolbar to insert 
your questions in context.  

READ - Break the material into sections to read and re-read the material section by 
section. Look for answers to your questions, identify key concepts, and supporting 
details. Study charts, graphs, tables, and pictures. These can serve to present new 
information as well as tie together concepts from the reading. Listen to the text using the 
Read button. Use the Dictionary to look up unfamiliar vocabulary and Highlight and 
Bookmark key information as you read. 

RECITE - Go back and 'pull out' the main ideas. This can be done using the Highlight or 
Bookmark feature. Using the List Feature you can create a separate document of the 
isolated information. After each section, paraphrase and summarize the key information 
using Text Notes and/or Voice Notes.  

REVIEW - After completing the entire chapter, scan back over the reading and review 
the information.  Use the Find button from the Yellow tool bar to jump quickly from one 
mark-up to the next.   Use the Voice Note to clarify and identify overall themes and 
relationships between concepts. Make any necessary revisions of your Highlights, 
BookMarks, Text Notes and Voice Notes so they can be easily understood when you re-
visit the key information.   
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7. Working with Internet Text in WYNN 
 

 
 
 

You can read directly from the Internet with WYNN.  You can also bring text from the 
Internet into a WYNN document to save and use with WYNN’s study tools. 
 

1. From the blue toolbar in WYNN, click the “Go to Web” button.  
 
2. Use the Search button to search for a topic, or type the address for a website 

into the address field.  (Note: WYNN automatically uses Google when you use 
the Search button). 

 
3. Read text directly from the Internet using one of three methods: 

 
a. Original View: just click the Read button  
b. Click the WebMask™ button to see everything grayed out except the area 

where you’re reading  
c. Click Text View to see text only, displayed in your preferred size, spacing, 

and background color.  
 

4. Select and Copy text you wish to work with in WYNN:  
 

a. Select text (dragging mouse or Select All command) 
b. Copy text (Copy button or right mouse click, then Copy) 
c. Open a New WYNN document or use Other Doc to switch to an already 

open document. 
d. Paste text (right mouse click, then select Paste) 
 

5. Save your document as a WYNN file.  Remember to save new changes as you 
make them. 

 
6. Use a Highlight pen to highlight key information, then the List button to create a 

separate document with just the highlighted text. 
 

Refer to the “Studying” tip sheet for additional ideas of how to work with the text for 
better comprehension. 
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8. Word Prediction:  Adding New Vocabulary 

 
You want your students to be able to read about a topic, then write about the topic.  You 
want word prediction to make suggestions of words so that your students can focus on 
getting their ideas down on paper, regardless of their ability to spell the specialized 
vocabulary for this topic area… 
 

1. Bring text into WYNN by scanning it, copying and pasting it from the 
Internet, or opening an existing file. 

 
2. Go to the Advanced menu and choose Word Prediction Teacher 

Controls 
 

3. Click the Word Prediction Learning Text tab 
 

4. Click the Current Document button 
 

5. The text from your open document will be added to the Word 
Prediction vocabulary of the logged in user 

 
6. Open a New file, click the Write button to enter edit mode, and start 

writing about the subject. 
 
 
You can increase the probability of this specialized vocabulary appearing in the 
prediction box by telling Word Prediction to use only the learned text. 
 

1. Go to the Advanced menu and choose Word Prediction Teacher 
Controls 

 
2. Click the Word Prediction Lists tab 

 
3. Uncheck all but the last item, “Use text learned from typing, text 

files, and documents” 
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9. Preparing Documents in WYNN 
 
The following are steps for bringing a document into WYNN and creating a clean 
electronic version of the document.  These steps will ensure that the text is being read 
correctly whether reading from Text View or Exact View. 
 

1. Import Document into WYNN 
a. Scanning 
b. Freedom Import Printer 

2. Dynamic Zone 
3. Clean-up Recognition Errors 
4. Spell Check  
 

Scan (to bring a print document into WYNN) 
1. Create a separate document for each chapter or unit 
2. Use Batch scanning if scanning several pages at once (Settings menu, 

Scanning Settings) 
3. Press the Scan button on blue tool bar (F3) to start scanning 
  

Freedom Import Printer (to bring an electronic file into WYNN) 
1. From any application, open the file to be imported into WYNN 
2. Issue a “print” command (Ctrl-P or File menu, Print) 
3. Select “Freedom Import Printer” from the list of printer drivers listed in the “Name” 

field, then click “OK.” 
 

Dynamic Zoning (separate tip sheet available) 
On books with complex formatting and extensive graphics, Dynamic Zoning highly 
reduces the number of recognition errors left to clean up, and provides a document that 
is presented in the most logical reading order.   Although there may be a page here or 
there that doesn’t benefit from re-zoning, it requires less time to rezone a block of pages 
at one time than it does to evaluate each page for the need to rezone.   
 

1. From the Advanced menu, select Dynamic Zoning (Ctrl-F5) 
2. Note the page number you are starting on. 
3. Re-Define zones on current page  

• Use your mouse to draw boxes (zones) around blocks of text in the correct 
reading order: If there is a block of text continued from previous page, do 
that section first, especially if the page break was in the middle of a 
sentence. 

• Keep complete sections of text together.   
• Do NOT zone pictures. 
• If there is text inside a box, zone only the text, not the borders of the box. 
• Zone the page number at the bottom. 
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 (Preparing Documents continued) 
 

4. When you reach the bottom of a page, hit the page down key until the next page 
appears. 

5. Click the Re-Define button to choose to re-define the zones on this page, and 
then repeat steps above. 

6. When you have re-zoned several pages, click the Re-Process button.  (**If doing 
several pages at once, note the number of the first page being recognized so that 
you can go back to it for Document Clean-up.) 

7. Each page that you have re-zoned will be re-recognized using the new zones. 
 
Document Clean-up (separate tip sheet available) 

1. Click the Clean-up button on the blue tool bar to see a split screen of the Text 
View and Exact View. 

2. Visually scan for errors on the Text View and replace with correct characters. 
Use the Exact View at the bottom of the screen to reference the original 
document.   Note: You MUST add the new text before removing the incorrect 
text. 

3. Remove any extra spaces at ends of lines.   
4. Remove spaces between lines unless they are there in the original document 
5. Maintain italics and bold face text as they appear in the original document. 

(Select the text, then use Ctrl B for boldface, Ctrl I for italics, Ctrl U for underline.  
These functions are also available on the Edit menu and the Yellow tool bar.) 

 
Spell Check 
There are buttons on the Yellow tool bar for the Spell Check and Find functions.  The 
keyboards commands are listed in the steps below.   
 

1. F7 enters Spell Check.  Spell Check does a good job catching words that have 
been run together.  It also catches misspellings that are hard to catch when you 
are doing a quick visual scan (i.e. cornpare for compare, ski!ls for skills, zero for 
O, and one for lower case L) 

2. Ctrl-F enters Find mode.  You can jump to a string of characters to make 
corrections.  For example, if you saw an error while spell checking but weren’t 
able to correct it, you can enter the Find command, type in the search string, and 
jump quickly to the error. 
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9a.  Scanning in WYNN 
 
 
To scan a page or document, click the Scan button from the blue tool bar.   
 
While the page is being scanned, a dialog box informs you that WYNN is processing the page.  
To interrupt scanning, you can press the Cancel button on this dialog box.  There may be a slight 
delay before WYNN interrupts the scanning process.  Once scanning is done, WYNN displays 
the scanned page on your screen in Text View.  Click the Exact View button to see an exact 
image of the original page.   
 
Scan Menu (ALT+S).  This menu lets you control how WYNN scans and displays the page after 
scanning it.   
 
Scan and Insert New Page (Scan Menu item) (I).  Select this menu item to scan a page and have 
it inserted before the page where the cursor is currently located.  WYNN lets you insert a new 
scanned page into any document, including a word processing file that was opened in WYNN.   
 
Scan and Replace Current Page (Scan Menu item) (R).  Select this menu item when you are in 
a scanned document, to scan a page and have it replace the current scanned page.  This option is 
useful if you are reading a scanned document and come to a page that contains many recognition 
errors.  Scan and Replace Current Page lets you re-scan that page and put it in the right place in 
your document.  You may wish to adjust contrast or other scanning settings prior to re-scanning 
the page.   
 
In addition to the items on the Scan menu, WYNN provides a number of other ways to modify 
the scanning process.   
 
OCR Correction (Advanced menu) – Use this to have WYNN automatically correct recognition 
errors. 
 
Scanning Settings (Settings menu) – Set up batch scanning, change contrast settings, and 
modify other settings that fine tune the scanning process. 
 
Dynamic Zoning (Advanced menu) (ctrl F5)– Dynamic zoning lets you change the reading 
order on any page.  You can also use Dynamic Zoning to have WYNN ignore areas of a page, 
such as page numbers and diagrams, that you don’t want spoken.  See the Dynamic Zoning tip 
sheet for more details. 
 
Document Clean-up (Button on blue tool bar) – provides a split screen of Text View and Exact 
View so you can clean up recognition errors in Text View while referencing the Exact View 
(original image.)  See the Document Clean-up tip sheet for more details. 
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9b. Opening PDF and other File Formats in WYNN Wizard  
 

WYNN Wizard includes a virtual printer that provides the ability to convert files from 
PDF files, or any other file format, to a WYNN document.  This virtual printer, called 
the Freedom Import Printer, shows up on the list of printer drivers in the Print 
dialog box.  

 
You can bring PDF files into WYNN Wizard in two different ways:  by opening from 
within WYNN, or opening in Adobe Reader, then “printing” to WYNN using the 
Freedom Import Printer. 
 
Opening a PDF file from within WYNN  

 
1. Launch WYNN  
2. Using the Open button, change the "Files of type" field to Adobe PDF 

Documents. 
3. Select the PDF file you want, and press the Open button. 
4. The file will automatically be converted to a WYNN file format. 
 
Converting a PDF file, or file of any other format, from outside of WYNN using 
the Freedom Import Printer.   
 

This process also works for converting PDF files you encounter when 
browsing the Internet.    

 
1. From any application, open a file you want to send to WYNN Wizard. 
2. From the File menu, choose Print.  Select Freedom Import Printer as your 

printer. 
3. If desired, specify the range of pages to be “printed”. 
4. Click OK. 
5. The Freedom Import Printer will convert the document to a WYNN file. 

If WYNN is not open, the Virtual Printer will open it.   
6. You may wish to save the file as a .wyn file when you initially bring it 

into WYNN.   
You can use this virtual printing method with many types of files: Microsoft Word, 
WordPerfect, PDF, HTML, text files, and many others.  Just open the file and print it to 
the WYNN Freedom Import Printer.   
 

Please note:  The Freedom Import Printer is only available in WYNN 
Wizard.  This function is not available in WYNN Reader. 
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9c. Dynamic Zoning in WYNN 4 

 
 

Dynamic Zoning Tool Bar Buttons 
 

Dynamic Zoning allows you to define your own reading order on a scanned page.  
Dynamic Zoning can also be used to avoid recognition errors from graphics, or to 
exclude the speaking of headers, footers, or other unwanted text.  WYNN 4’s new 
Dynamic Zoning Tool Bar facilitates the process. 
 
From the Advanced menu, choose Dynamic Zoning, and then Enable Dynamic 
Zoning.  Alternatively, Ctrl-F5 enters Dynamic Zoning.  This brings up the Dynamic 
Zoning tool bar.   

 

 Select Re-define to remove the current zone indicators so that you can 
redraw the zones in the correct order. 

 
Use your mouse to draw a box around each block of text you wish to have 
spoken.  The reading order is determined by the order in which you define the 
zones. Do not draw zones around pictures or other graphic images that can’t be 
spoken. 

 
Hit the Page Down key if you want to change the zones on the next page.  You 
will see existing zones in blue for that page.  Follow the steps above to re-define 
the reading order for that page.  Repeat this process for each page you wish to 
re-zone. 

 

 When you are done defining new zones on all pages that apply, select the 
Re-Process button.  This tells WYNN to re-recognize the document using the newly 
defined zones, in the order in which they were created. 

 

 Use Revert prior to re-processing your new zones, if you wish to return to the 
original zones on the page. 
 

 Use Erase if you wish to erase all the zones you have created and start from 
scratch. 
 
* Use Dynamic Zoning prior to doing Document Clean-up! 
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9d. Document Clean-up in WYNN 4.0  
 

Document Clean-up provides the tools necessary to correct OCR errors 
that may occur in the document during scanning.  This ensures that the 
document will be spoken correctly by WYNN.  Always do this process 
second, when using Dynamic Zoning! 
 

In Document Clean-up, you view both the Exact View and the Text-only 
View of the document.  The Text View appears on top, with the Exact View 
on the bottom.  The Text View is what WYNN uses to read aloud, 
regardless of which view you choose to look at as you read.  Note that 
when reading from Exact View, Document Clean-up does not change the 
appearance of the Exact View, only how the text will be spoken.  
 

To use Document Clean-up: 
 

1. Click the Clean-up button on the blue tool bar. 
 
2. Place the cursor over the Text View, which is on the top part of the screen, and 

click the mouse button. 
 

3. Scroll through the Text View of the document looking for errors.  A pink box will 
highlight the corresponding location of the text in Exact View, shown at the 
bottom half of the screen. 

 
4. Correct errors by placing the cursor next to the error and clicking the mouse 

button.  This will place the insertion cursor next to the error. 
 

It is critical to correct errors in the exact order listed below:  
5. First, type in the correct characters in a word.  Then delete the incorrect 

characters.  When correcting errors, do not delete the whole word or item to be 
corrected.  First, type in the corrections, then delete the errors.  Deleting the 
entire item and retyping it would erase the link that WYNN uses to highlight the 
item when reading from Exact View.  (Think of it as a lifeline: you always need at 
least one strand of the rope.  You can add new strands, then remove any 
strands, old or new, as long as one strand is remaining.  But you can't remove all 
the strands, then throw new ones, because there is nothing to grab onto in the 
meantime.) 

 
6. Repeat steps 4 and 5 until all corrections are made.   

 
7. To exit Document Clean-up, click the Clean-up button on the blue tool bar. 
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Don't forget to save your document after you have finished with Document Clean-up. 
 

10. Creating a Custom Tool Bar 
 
You can create a Custom Tool Bar in WYNN, using only the buttons you 
want available for a specific student or task.  To do so: 
 

1. Click on the Settings menu. 
2. Choose Custom Tool Bar. 
3. Click on each button you want on the Custom Tool Bar, then click the 

Add button. 
4. When you have finished creating your Custom Tool Bar, click the 

radio button that says “Show Custom Tool Bar”. 
5. Click the OK button. 
6. If you want to add buttons to an existing Custom Tool Bar, retrieve 

the tool bar, then follow the steps above. 
 
If you want this tool bar to come up for a particular user each time they log 
into WYNN, you must save this setting as their Default.  (See the 
document titled “Saving Settings” for more details.) 
 
If you want to Retrieve this Custom Tool Bar only when needed, you can 
save it with a name other than Default, then Retrieve it when you wish to 
use it.  To do so: 
 

1. Go to the Settings menu. 
2. Choose Save Settings. 
3. Give these settings a descriptive name, then click OK. 

 
To Retrieve this Custom Tool Bar when you wish to use it: 
 

1. Go to the Settings menu. 
2. Choose Retrieve Settings. 
3. Click on the name you created for this Custom Tool Bar, then OK. 

 
To Retrieve the Default Tool Bars, Go to Settings, Custom Tool Bar, 
and click on the radio button, “Show Default Tool Bar”. 
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11. Sample Activities for Using WYNN 
 
Vocabulary Development 

Use a sample file or copy and paste a poem from www.poetry4kids.com into a 
WYNN document. 
Create a vocabulary list using the Highlight and List features.   
Copy and paste definitions from the dictionary.   
Use a Voice Note to use each word in a sentence. 

 
Write a paragraph about the “diet of land crabs” using source material from the 
Internet (you may choose your own topic if you wish.) 
 Find a topic related Website.   

Copy and Paste selected text into a WYNN document.   
Use the Word Prediction tip sheet to “learn” text for use with Word Prediction. 
Use Highlight/List to create a separate document of key points to include.   
Use Word Prediction to assist with writing paragraph.  

 
Create a Study Guide  

Use one of the sample files, or copy and paste text from the Internet into a 
WYNN document. 

 Identify main ideas and highlight in green. 
 Identify supporting points and highlight in pink. 

Using the List button, create a separate document of key and supporting points. 
 

Identify Parts of Speech 
Open a sample file or bring a poem from www.poetry4kids into a WYNN 
document. 
Use the green highlight pen to highlight 5 verbs. 
Use the pink highlight pen to highlight 5 nouns. 
Use the blue highlight pen to highlight 5 adjectives. 
Create a List, by color, to create a word list by part of speech. 
 

Explore the electronic text links available on our website, 
http://www.freedomscientific.com/lsg, under “Resources”  
 
Scan a page and practice the steps for cleaning up recognition errors (see tip 
sheet) 
 
Create a Custom Tool Bar  (see tip sheet) 
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Explore tip sheets available at 
http://www.freedomscientific.com/lsg/products/wynn_tipsheets.asp  


